RMC200 Motion Controller
Startup Guide
With wiring diagram
Where to Get Help

Video Tutorials

In RMCTools, on the Help menu, click Video Tutorials

RMCTools Help

In RMCTools, on the Help menu, click Help Topics

Forum

Visit forum.deltamotion.com

Delta Technical Support

Phone: +1-360-254-8688

Email: support@deltamotion.com
WARNING: Using this product in a manner not specified by the manufacturer may impair the protection provided by the equipment.

WARNING: Employ safety circuits or devices external to the motion controller to ensure the machine operates safely even in the event of a failure in any part of the controller.

WARNING: If deemed necessary by a risk assessment, employ an emergency stop system to avert harm or to reduce existing hazards to persons, machinery, or work in progress.

WARNING: Use proper lock-out procedures when working on the machine to prevent injury or machine damage.

WARNING: On hydraulic systems, use blocking valves or other suitable methods to prevent the hydraulic system from moving unexpectedly when working on the machine.

WARNING: Use fuses to limit any fault currents that could cause smoke or fire due to a fault in the RMC or external device.

WARNING: Using this product in a manner not specified by the manufacturer may impair the protection provided by the equipment.

WARNING: Employ safety circuits or devices external to the motion controller to ensure the machine operates safely even in the event of a failure in any part of the controller.

WARNING: If deemed necessary by a risk assessment, employ an emergency stop system to avert harm or to reduce existing hazards to persons, machinery, or work in progress.

WARNING: Use proper lock-out procedures when working on
the machine to prevent injury or machine damage.

**WARNING:** On hydraulic systems, use blocking valves or other suitable methods to prevent the hydraulic system from moving unexpectedly when working on the machine.

**WARNING:** Use fuses to limit any fault currents that could cause smoke or fire due to a fault in the RMC or external device.
### Contents

Step 1: Mount the Base .................................................. 2  
Step 2: Mount the Modules ............................................. 4  
Step 3: Wiring ................................................................. 5  
Step 4: Install RMCTools ............................................... 6  
Step 5: Connect RMC to PC ........................................... 7  
Step 6: Start a New Project ............................................ 8  
Step 7: Define the Axes ................................................ 13  
Step 8: Test each Actuator ........................................... 15  
Step 9: Test each Feedback Device ......................... 19  
Step 10: Scale and Offset ............................................. 25  
Step 11: Set the Output Polarity ................................. 26  
Step 12: Tuning ............................................................ 27  
Continuing the Motion Application .......................... 30  
Diagnostic Tools ........................................................... 33  
Appendix A: Wiring ....................................................... 34  
Appendix B: Mounting Dimensions ......................... 56  
Appendix C: Agency Compliance ................................. 59

Version 1.08, June 19, 2023  
Copyright © 2023, Delta Computer Systems, Inc., also doing business as Delta Motion.

Delta Motion is a U.S. registered trademark of Delta Computer Systems, Inc.
Step 1: Mount the Base

The RMC base should be mounted upright on a vertical surface, such that the module ventilation holes are on the top and bottom.

**Mounting the Base on a Panel**

Mounting holes sized for #10 or 5mm screws.

See Appendix B: Mounting Dimensions on pg. 56 for more details.

**Clearance**

The required clearance above and below for airflow depends on the maximum ambient temperature:

<table>
<thead>
<tr>
<th>Ambient Temperature</th>
<th>Clearance</th>
</tr>
</thead>
<tbody>
<tr>
<td>122 - 140°F (50 - 60°C)</td>
<td>3 in. (7.6 cm)</td>
</tr>
<tr>
<td>Less than 122°F (50°C)</td>
<td>2 in. (5.1 cm)</td>
</tr>
</tbody>
</table>

**Environment**

The environment must conform to the following:

- Operating ambient temperature: -4 to +140°F (-20 to +60°C)
- Storage ambient temperature: -40 to +185°F (-40 to +85°C)
- Ambient humidity: 5-95%, non-condensing

Keep liquids and conductive particles away from the RMC200.
Enclosure

If the RMC200 is installed in an electronics enclosure, the enclosure must be large enough to dissipate the power that is being generated by the components in the cabinet without having the air temperature in the cabinet exceed the rating on any of the components within the cabinet.

To ensure sufficient convection, the enclosure should provide the following clearances:

- At least 2” between the front of RMC200 and the enclosure
- At least 3” between the top of RMC200 and the enclosure
- At least 3” plus space for wires between the bottom of RMC200 and the enclosure

Grounding

**IMPORTANT:** Make sure to properly ground the base metal. Mounting via steel screws to a well-grounded surface such as a metal panel will typically suffice. To ensure a robust connection, the grounding stud on the bottom of the base may be used. The Case pins of each module are electrically connected to the module chassis, which will conduct to the base chassis.

**WARNING:** Electrostatic Discharge (ESD): Electrostatic discharge can cause internal damage and affect normal operation. When handling this equipment, follow these guidelines:

- Touch a grounded object to discharge potential static or wear a grounding wrist strap.
- Do not touch connectors or pins on the module boards or electronic components inside the modules.
- Use a static-safe workstation, if possible.
- Store modules in ESD packaging when not in use.
Step 2: Mount the Modules

Module Locations

Modules are keyed so only compatible modules mount in a given slot.

<table>
<thead>
<tr>
<th>Slot</th>
<th>Compatible Modules</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>RMC200 Lite: Bases B5L, B7L</strong></td>
<td></td>
</tr>
<tr>
<td>0/1</td>
<td>CPU20L (fits in combined slot 0 and 1)</td>
</tr>
<tr>
<td>2+</td>
<td>CA4, CV8, S8, A8, Q4, LC8, D24, U14</td>
</tr>
<tr>
<td><strong>RMC200 Standard: Bases B5, B7, B11, B15</strong></td>
<td></td>
</tr>
</tbody>
</table>
| 0    | PS4D (for B5, B7 or B11)  
     | PS6D (for B15) |
| 1    | CPU40 |
| 2+   | CA4, CV8, S8, A8, Q4, LC8, D24, U14 |

The CPU20L and CPU40 are not interchangeable. The CPU20L requires the B5L or B7L base while the CPU40 requires the B5, B7, B11, or B15 base, along with a PS4D or PS6D power supply. All of the I/O modules can be used in any base module.

Install each Module

1. Tip the module up.
2. Set the upper pins in the hooks.
3. Rotate the module down carefully such that the base connector engages.
Step 3: Wiring

Wire the power, actuators, and feedback devices to the RMC according to the instructions in Appendix A: Wiring on page 34.

**IMPORTANT:** Remove external power from the device before wiring. Failure to do so may cause component failure.

After wiring, remove the protective plastic from the top of the modules.

### Wiring Topic

<table>
<thead>
<tr>
<th>Wiring Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>General Wiring Information</td>
<td>35</td>
</tr>
<tr>
<td>Power</td>
<td>PS4D, PS6D, CPU20L</td>
</tr>
<tr>
<td>Analog Outputs</td>
<td>CA4, CV8, U14</td>
</tr>
<tr>
<td>Analog Inputs</td>
<td>A8, U14</td>
</tr>
<tr>
<td>Discrete I/O</td>
<td>CPU20L, CPU40, CA4, CV8, U14</td>
</tr>
<tr>
<td></td>
<td>D24</td>
</tr>
<tr>
<td>SSI Inputs</td>
<td>S8, U14</td>
</tr>
<tr>
<td>Start/Stop and PWM (MDT)</td>
<td>S8, U14</td>
</tr>
<tr>
<td>Quadrature Encoder</td>
<td>S8</td>
</tr>
<tr>
<td></td>
<td>Q4, U14</td>
</tr>
<tr>
<td></td>
<td>D24</td>
</tr>
<tr>
<td>Load Cell</td>
<td>LC8</td>
</tr>
</tbody>
</table>
Step 4: Install RMCTools

Download

1. Go to deltamotion.com/dloads/

2. Choose the **RMC200** section, then choose the **Software** section.

3. Choose RMCTools, 32-bit or 64-bit, as required for your computer. RMCTools supports the RMC75, RMC150 and RMC200 controllers.

4. Run the rmctoolsinstall32.exe or rmctoolsinstall64.exe file and follow the instructions.

Start RMCTools

On the Windows **Start** menu, choose **All Programs** and then **RMCTools**.

### PC Requirements for RMCTools

| Operating System | Windows® 7/8.1/10/11 |
Step 5: Connect RMC to PC

**USB Cable**
Connect an A to B USB cable to the PC and the RMC200 USB port.

This type of USB cable is typically used for PC peripherals such as printers and is available at any store that sells electronics.

**Or, use Ethernet Cable**
Connect an Ethernet cable to the RMC200 and the PC or Ethernet switch. The RMC200 supports both straight-through and crossover cables.

**Setting the IP Address**
The IP address need not be set before connecting via Ethernet. If the PC is on the same physical Ethernet network as the RMC, RMCTools can detect the RMC even if the IP address is not set.

The RMC’s IP address and the subnet mask can be set via RMCTools while connecting via Ethernet. See the next step *Start a New Project* for details.

Or, set the IP address and subnet mask via the CPU display screen:

1. Using the **Menu**, **arrow** and **Enter** buttons, browse to: Ethernet → Change IP Address → Set manually
2. Using the arrow **buttons**, set the IP address.
3. Press **Enter** for Next and set the subnet mask.
4. Choose whether to set a default gateway. Set it if so desired.
Step 6: Start a New Project

1. Start RMCTools.
   In the **Startup** dialog, select **Create a New Project** and click **OK**.

2. Enter the **Project Name**, then click **Finish**.

3. In the **New Controller Wizard**, choose **Automatically Detect the Controller Information**, then click **Next**.
4. Communication Method:

Via USB:

A. Select USB and click Next.

B. The RMC200 will appear in the list as **R200-CPU40** or **R200-CPU20L**. Choose the RMC and click Next.

**Tip:** If multiple controllers are listed, use the serial number to identify your RMC in the list (Device ID). The serial number is accessible on the RMC200 display screen:

1. Using the **Menu**, arrow and **Enter** buttons, browse to **Module Info**, then the CPU module.
2. The serial number is prefixed by “**SN:**”

C. RMCTools will connect to the RMC and display it. Verify it is correct, then click **Finish**.
Via Ethernet:

A. Select **Ethernet** and click **Next**.

B. The RMC200 will appear in the list as **R200-CPU40** or **R200-CPU20L**. Click the RMC and click **Next**.

Tip: If multiple controllers are listed, use the MAC address to identify your RMC in the list. The MAC address is accessible on the RMC200 display screen:

1. Using the **Menu**, arrow and **Enter** buttons, browse to:
   - Ethernet → View IP Address
2. Using the arrow buttons, scroll down to view the MAC address.

C. If the RMC does not have an IP address (0.0.0.0), you must set an IP address now in order to connect via Ethernet:

   a. Click **Configure Device**.
Step 6: Start a New Project

b. Select **Use the following IP address**, set the **IP Address** and **Subnet Mask**, then click **OK**.

**Tip:** For help on IP addressing, in the RMCTools help, in the Index tab, type IP Address and choose that item from the list.

D. Click **Next**. RMCTools will connect to the RMC and display it. Verify it is correct, then click **Finish**.

5. The toolbar now displays **Online (Disabled)**. This means RMCTools is communicating with the controller.

### Project Pane

The project pane contains all the items in the project. Use the Project pane to navigate through the entire project.
Set Up Module Channels

If your RMC200 includes a U14 or S8 module, you may first need to set up the high-speed channels before using them as part of an axis.

U14: The channels can be configured as SSI, MDT, or quadrature.

S8: Channels 7-8 can be configured as an SSI input (default), SSI monitor, or a quadrature input.

1. In the Project pane, expand the Modules folder and double-click the module.

2. On the Configuration page, choose the desired mode for each channel. For more details, click Help.

Saving Settings

Throughout the startup procedure, make sure to save the configuration changes you make, or they may be lost!

1. Save RMCTools Project

On the File menu, click Save.

2. Update Flash

On the Controller menu, click Update Flash.

IMPORTANT: If you do not update Flash, changes to the RMC will be lost when power is removed!

3. Repeat Often

Make sure to save often to prevent loss of data.

Tip: On the File menu, click Save and Update Flash to perform both operations at once.
Step 7: Define the Axes

To use a physical input or output, it must be assigned to an internal software axis. The RMC starts with default axis assignments which you will likely need to change.

Make sure to define the axes at the start of the project. Making major changes to axis definitions later may result in lost axis parameters.

Example Axis Definitions

**Position Control Axis**
One Control Output, one position input.

**Position-Force Control Axis (all part of a single axis)**
One Control Output, one position input, dual-input force

**Reference Axis**
One position input.
**View Axis Definitions**

1. In the Project tree, expand the **Axes** folder and double-click **Axis Definitions**.

2. The **Axis Definitions** dialog opens:
   
   The list displays the software axes. To see the assigned hardware, click an axis in the list. The hardware assigned to that axis will be highlighted in the image.

**Edit Axis Definitions**

Use the Axis Definitions dialog to change the axis definitions:

- Click **New** to add an axis.
- Click **Change** to edit the selected axis.
- Click **X** to remove an axis.

For more details, click the **Help** button.

After changing axis definitions, save the project and update Flash.
Step 8: Test each Actuator

You will now test an actuator such as a hydraulic valve or a motor. You will use the Direct Output command to send a command signal to the actuator. The actuator must already have been wired to the RMC.

Set the Output Type

1. In the Project tree, double-click *Axis Tools*.

2. In the *Axis Parameters*, on the Setup tab, set the Output Type to the correct setting for your actuator.

   **Supported output types:**
   - Voltage output: CA4, CV8, U14
   - Current output: CA4, U14

3. Click the Download button to apply the changes to the RMC.

4. In the *Axis Status Registers*, on the Basic tab, look at the Control Output.

   It should be 0.

   Notice that the Final Output shows the output value in Volts or mA.
Enable the Axes – Enable Controller (7) Command

5. In the Command Tool, in any axis box, click the button.

6. Browse to General Commands, click Enable Controller, then click OK.

   The Enable Controller command enables all the axes so motion commands can be sent to them.

7. In the Command Tool, click Send.

   All the axes will now be enabled, as indicated by the Enabled Status bit in the Axis Status Registers.

   Entering RUN Mode will also enable the axes.
Step 8: Test each Actuator

**Move the Axis - Direct Output (9) Command**

**WARNING:** Use the Direct Output (9) command with caution. It disables the Autostop features of the axis.

**Fault Controller Button**
In the next steps, if you need to quickly stop the axis, click the **Fault Controller** button on the toolbar, or press Ctrl + K on the keyboard.

8. In the Command Tool (see step 5) browse to **Motion Commands**, then **Open Loop**.
   Choose the **Direct Output** command and click **OK**.

   The Direct Output command is useful for setup because it ignores all axis errors.

9. For the Direct Output command parameters, enter the following:
   - **Output (%):** 10
   - **Ramp Rate:** 1000

   When you send the command in the next step, the Control Output will ramp to 10 % output at a rate of 1000 %/sec. This means an axis configured for ±10 V output will ramp the Control Output to 1 V in...
10 ms.

10. In the Command Tool, click **Send**.

The axis should move, and the **Control Output** (in the **Axis Status Registers**) should be 10.0.

11. If the axis did not move, resend the command with a larger **Output** until the axis moves.

**Note:** If the Enable Output is wired to the actuator, before moving, set it with the **Set Enable Output** command.

12. Now stop the axis:
   
   In the Command tool, enter 0 in the **Output** box and click **Send**.

13. Repeat these steps to move the axis in the other direction. In the Direct Output command, use a negative **Output** value. Move the axis back and forth through the entire travel range to make sure the axis is moving properly.
Step 9: Test each Feedback Device

Now that you have connected and tested an actuator, you will verify a feedback device. The device must already have been wired to the RMC.

Configure Feedback

In Axis Tools, in the Axis Parameters pane, on the Setup tab, you will configure certain parameters depending on the type of input you are using.

Refer to the procedure for your transducer type and module:

<table>
<thead>
<tr>
<th>Transducer Type</th>
<th>Module</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>SSI</td>
<td>S8, U14</td>
<td>20</td>
</tr>
<tr>
<td>Start/Stop or PWM (Magnetostrictive)</td>
<td>S8, U14</td>
<td>21</td>
</tr>
<tr>
<td>Analog (Voltage or Current)</td>
<td>A8, U14</td>
<td>21</td>
</tr>
<tr>
<td>Quadrature Encoder</td>
<td>Q4, S8, D24, U14</td>
<td>22</td>
</tr>
<tr>
<td>Load Cell</td>
<td>LC8</td>
<td>23</td>
</tr>
</tbody>
</table>
1. In the Axis Parameters pane, on the Setup tab, set the Feedback Type to SSI.

2. Set the following parameters:
   - SSI Format
   - SSI Data bits (e.g. 24)
   - Linear/Rotary

Choose Format and Data Bits per the SSI device datasheet. For linear transducers, choose Linear. For rotary encoders, choose Rotary if the axis on your machine can rotate continuously and the positions wrap around, or Linear, if it has a limited travel range and the encoder will not cross the zero counts point.

**NOTE:** For help on a parameter, click the cell and press F1.

3. Depending on the I/O module and the sensor, there may be other parameters that need to be set. See the SSI Fundamentals RMCTools help topic for your module for details.

4. Click the Download button to apply the changes to the RMC.

Step 9: Test each Feedback Device

Start/Stop or PWM (Magnetostrictive) Feedback

1. In the Axis Parameters, on the Setup tab, set the Feedback Type to MDT.

2. Set MDT Type to the type of magnetostrictive transducer you have. This information is available from your transducer datasheet.

3. Click the Download button to apply the changes to the RMC.


Analog Feedback

1. In the Axis Parameters, on the Setup tab, set the Analog Input Type to Voltage (±10V) or Current (4-20mA).

   If the input is the primary input of the axis, the Input Type is under the Primary Control Setup section in the Axis Parameters.

   For pressure or force inputs on a dual-loop axis, the Input Type is in the Secondary Control Setup section in the Axis Parameters.

2. Click the Download button to apply the changes to the RMC.

1. In the **Axis Parameters**, on the **Setup** tab, set the **Linear/Rotary** parameter.
   
   For linear transducers, choose **Linear**. For rotary encoders, choose **Rotary** if the axis on your machine can rotate continuously and the positions wrap around, or **Linear** if it has a limited travel range.

2. Depending on the I/O module, there may be other parameters that need to be set, for example, to define the input signal levels. See the RMCTools help topic for your module for details.

3. Click the **Download** button 🔄 to apply any changes to the RMC.

Step 9: Test each Feedback Device

Load Cell Feedback

1. In the Axis Parameters, on the Setup tab, in the Primary Control Setup or Secondary Control Setup section, locate the Exciter Mode parameter.

Choose the Exciter Mode based on the desired method of compensating for voltage drop in the Exc+ and Exc- wires:

- **No Compensation:**
  Set Exciter Mode to Nominal.

- **Sense Input During Setup (4 or 6 wire load cells):**
  Compensate by using the LC8’s Sense input measurement of the actual exciter value at the load cell during setup:
  a) Set Exciter Mode to Fixed Value. The Fixed Exciter Voltage parameter will appear.
  b) In the Axis Status Parameters, on the All tab, copy the Effective Exciter Voltage into the Fixed Exciter Voltage parameter.

- **Continuous Sense Input Measurement (6 wire load cells):**
  Compensate by using the LC8’s Sense input to continuously measure the actual value at the load cell:
  a) Set Exciter Mode to Adaptive.

- **Manual Measurement During Setup (4 or 6 wire load cells):**
  Compensate by measuring the actual exciter value at the load cell during setup with a voltmeter:
  a) Set Exciter Mode to Fixed Value. The Fixed Exciter Voltage parameter will appear.
  b) With a voltmeter, measure the voltage across the Exciter+ and Exciter- wires as close to the load cell as possible. Enter this voltage into the Fixed Exciter Voltage parameter.

4. Click the Download button to apply any changes to the RMC, then continue to the Verify Feedback section on page 24.
Verify Feedback

1. In the **Axis Status Registers** pane, on the **All** tab, expand the **Feedback** section.

   For secondary inputs, expand the **Pressure/Force/Accel Feedback** section.

2. Depending on your feedback type, look at the **Counts**, **Volts**, **Current**, or **Millivolts/Volt** register. It may be changing slightly.

3. Use the Direct Output command to move the axis back and forth (as described in the **Test an Actuator** section).

4. As the axis moves, look for a corresponding change in the **Counts**, **Voltage**, **Current**, or **Millivolts/Volt**. If it does not change smoothly, recheck the wiring, verify that the axis parameters are correct, and check for smoothly changing feedback again.

5. Save the project and update Flash.
Step 10: Scale and Offset

The Scale and Offset parameters convert the Counts, Volts, Current, or Millivolts/Volt from the feedback sensor into meaningful measurement units.

First, determine the approximate maximum and minimum feedback values that you expect, for example, the positions at both ends of travel. This will help you verify later that you performed the procedure correctly.

To set the Scale and Offset:

1. Go to the Axes Parameters pane, Setup tab, Tools and Wizards section.

2. Click Launch for the Scale/Offset Wizard in the desired axis.

3. In the wizard, follow the directions. For help, press the Help button.

Tip: If the wizard does not work for your system, you can manually determine the Scale and Offset parameters. See the Scaling topic in the RMCTools help for details.

4. Move the axis and verify that the feedback values are correct.

5. Click the Download button to apply the changes to the RMC. Remember to save your project and update Flash.
Step 11: Set the Output Polarity

**IMPORTANT:** The Actual Position, Pressure, Force, or Velocity must increase when the RMC applies a positive Control Output percentage. If this condition is not met, you will not be able to perform closed-loop control.

1. Send the Direct Output command with a positive Output value that is large enough to move the axis.

2. On the Basic tab of the Axis Status Registers pane, observe the actual feedback value of the axis (position, pressure, force, or velocity) and note whether it is increasing or decreasing:

   **Increasing**  
   The Output Polarity is correct. Go to Enable the Axes below.

   **Decreasing**  
   You must invert the Output Polarity:

   A. In the Axis Parameters pane, on the Setup tab, double-click the Invert Output Polarity parameter to set it.

   B. Click the Download button to apply the change to the RMC.
In order to control an axis in closed-loop, it must first be tuned. You can use autotuning or manually tune the axis.

**Autotuning – Position Axes Only**

Autotuning can be used for most position control axes.

1. **Open Tuning Tools**
   On the **Tools** menu, click **Tuning Tools**.

2. **Set Up Tuning Tools**
   Set up the buttons that you will use to move the axis back and forth after the tuning wizard completes.
   - Click the first button labeled **[Click to set up]**.
   - Enter a **Move Absolute** command with position, speeds, and acceleration values that will work for your system.
   - Repeat for the other button, with a different position.

3. **Start the Tuning Wizard**
   In the Tuning Tools, click **Tuning Wizard**.

4. **Complete the Tuning Wizard**
   During the autotuning, the wizard will move the axis a short distance when you prompt it to.
5. When the wizard is complete, the **Gain Calculator** will open. Use the slider bar to choose gains. Begin by pulling the slider close to the bottom, then click **Apply Gains**.

6. Use the buttons you previously set up to move the axis back and forth. The plot will automatically be displayed.

   **Tip:** To halt the axis, click the **Fault Controller** button on the toolbar, or press Ctrl+K.

7. If the Actual Position is not following the Target Position very well, pull the slider bar up, apply gains, and move the axis again. Repeat until the Actual Position tracks the Target Position as required for the application.

---

**Tuning With an Existing Plot**

If the autotuning does not work for your system, you can use the Tuning Wizard with an existing plot.

1. In the Tuning Tools, use the Move buttons to make moves and adjust the Proportional Gain until the axis has some control.
2. Start the Tuning Wizard and choose **Use Existing Plot**. The Wizard will prompt you to choose one of the plots of the moves you made.
3. When the wizard completes, use the Gain Calculator as described above.
Manual Tuning—Position, Pressure, or Force Axes

You can manually tune systems for which autotuning does not work. For instructions:

1. On the Help menu, choose Help Topics.
2. On the Index tab, type tuning and double-click about.
3. The Tuning Overview topic describes tuning. In the Manual Tuning section, choose a procedure. For most position control applications, choose Tuning a Hydraulic Position Axis or Motor in Velocity Mode. For pressure or force, choose the procedure that applies to your axis.

After tuning, save the project and update Flash.
Continuing the Motion Application

After setting up and tuning the RMC, it is ready to perform motion and be integrated into the rest of your application. The RMC has numerous features to assist you. The major components are listed here to guide you when continuing your motion application.

Commands

The RMC has a rich set of pre-programmed commands that perform anything from simple moves to complex motion to system control. For a list of all the commands, see the Command List topic in the RMCTools help.

User Programs

A User Program carries out simple or advanced sequences of commands on the RMC. This allows the RMC to respond to events within its control-loop time rather than the scan rate of a PLC or other host controller. It also reduces the PLC programming required.

A User Program consists of multiple steps linked together in sequences. Each step can issue any RMC command to one or several axes. The link types allow branching and looping, waiting for conditions, and many other features. Simple and complex mathematical operations are also possible in the user program.

A User Program runs on a task. Each task can run one user program at a time. The RMC200 has up to 32 tasks. Therefore, an RMC200 controller may run up to 32 User Programs simultaneously.

For details on creating and running User Programs, see the User Programs topic in the help.
Communications

Most PLCs or other host controllers can communicate with the RMC, which includes reading status, writing values, and sending commands to the RMC. The RMC200 supports several Ethernet protocols.

⚠️ WARNING: When the motion controller is remotely controlled by some other device, such as a PLC, make sure to design proper safety interlocks to ensure safe machine operation in the event of communications loss.

See the Communications section of the RMCTools help for more detailed information.

Discrete I/O

Discrete I/O augments the communications of the RMC. Discrete I/O is often faster than the communications and is therefore well-suited for starting a sequence in the RMC at a specific time. See the Discrete I/O topic in the RMCTools help for details.

Variables

Variables help make the User Programs very flexible and easy to maintain. Variables can be used to effortlessly change programs and easily modify User Program parameters via a PLC. Variables can also be used to store data.

For details on using variables, see the Variables topic in the help.
Program Triggers

Use the Program Triggers to start User Programs based on conditions defined by the user. For example,

- Start a User Program by writing to an RMC variable from a PLC.
- Start a User Program when a discrete input turns on.
- Automatically start a User Program when the RMC starts up.
- When an error condition occurs, automatically start a User Program to handle it.

See the **Program Triggers** topic in the RMCTools help for details.
Diagnostic Tools

This section describes the main diagnostic tools of RMCTools that will aid you in monitoring and troubleshooting your system.

Plots

The RMC provides very flexible plotting capabilities. Virtually any register in the RMC can be plotted, and multiple registers may be plotted simultaneously. You can easily capture events with the plot trigger. For details on using plots, see the Plots topics in the help.

**Note:** By default, each axis has a plot configured and a plot will be captured each time a motion command is sent to the axis.

Open the Plot Manager and click ![Capture](image) to view a plot. Or, click ![Trend](image) to view a continuous plot.

Event Log

The Event Log Monitor displays all events that have occurred in the controller, such as issued commands, changed parameters, and errors. The Event Log can help you:

- Determine if a command was successfully issued. The entire command, with parameters, is displayed.
- Find out which, if any, error occurred.
- See where a command was issued from, for example, from a PLC, a User Program, or the Command Tool.

**To open the Event Log:**

- In the Project Pane, expand the controller, and double-click Event Log.

**Note:** The Event Log is very useful! When you don’t know what happened, or why something did not happen, look at the Event Log.
Appendix A: Wiring

This appendix describes how to wire the RMC. Use the table below to find the wiring diagram you need. For communications wiring, consult the RMCTools help.

**WARNING:** Remove external power from the device before wiring. Failure to do so may cause the module to fail.

<table>
<thead>
<tr>
<th>Wiring Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>General Wiring Information</td>
<td>35</td>
</tr>
<tr>
<td>Power</td>
<td>PS4D, PS6D, CPU20L</td>
</tr>
<tr>
<td>Analog Outputs</td>
<td>CA4, CV8, U14</td>
</tr>
<tr>
<td>Analog Inputs</td>
<td>A8, U14</td>
</tr>
<tr>
<td>Discrete I/O</td>
<td>CPU20L, CPU40, CA4, CV8, U14</td>
</tr>
<tr>
<td></td>
<td>D24</td>
</tr>
<tr>
<td>SSI Inputs</td>
<td>S8, U14</td>
</tr>
<tr>
<td>Start/Stop and PWM (MDT)</td>
<td>S8, U14</td>
</tr>
<tr>
<td>Quadrature Encoder</td>
<td>S8</td>
</tr>
<tr>
<td></td>
<td>Q4, U14</td>
</tr>
<tr>
<td></td>
<td>D24</td>
</tr>
<tr>
<td>Load Cell</td>
<td>LC8</td>
</tr>
</tbody>
</table>

**WARNING:** Miswiring may cause damage to the RMC200 and connected components.

**WARNING:** Pay special attention to wiring the Common pins, or the RMC may not properly receive signals from connected transducers.
General Wiring Information

To minimize electrical interference:
- Use twisted pairs for all wiring where possible.
- Use shielded cables for all wiring.
- Keep RMC wiring separate from AC mains or conductors carrying high currents, especially high frequency switching power such as conductors between servo drives and motors or amplifiers and proportional valves.
- Use separate power supplies for sensors and actuators.

Unpluggable Terminal Blocks

All RMC200 modules employ unpluggable terminal blocks. Features of these terminal blocks include:
- Latching type to prevent unintended extraction
- Spring-cage connectors for consistent wire clamp force

Using Spring-Cage Connectors

Spring-cage connectors may be used for stranded copper wire or stranded copper wire with ferrules. Wire ferrules provide easy insertion.

Inserting stranded wire:
1. Press and hold the spring clamp actuator.
2. Insert wire.
3. Release spring clamp actuator.

Inserting wire with ferrule
1. Insert wire (may require some force).

Removing wire (stranded or ferrule):
1. Press and hold the spring-cage actuator.
2. Remove wire.
### Wire Gauge, Stripping Length, and Ferrule Length

**IMPORTANT:** Use copper wire only.

<table>
<thead>
<tr>
<th></th>
<th>PS4D, PS6D</th>
<th>CPU20L, CPU40, CA4, CV8, S8, A8, Q4, D24, U14</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wire gauge, stranded</td>
<td>24 – 12 AWG 0.2 – 2.5 mm²</td>
<td>24 – 16 AWG 0.2 – 1.5 mm²</td>
</tr>
<tr>
<td>Wire gauge, ferrule no plastic sleeve</td>
<td>0.25 – 2.5 mm²</td>
<td>0.25 – 1.5 mm²</td>
</tr>
<tr>
<td>Wire gauge, ferrule with plastic sleeve</td>
<td>0.25 – 2.5 mm²</td>
<td>0.25 – 0.75 mm²</td>
</tr>
<tr>
<td>Stripping Length</td>
<td>10 mm</td>
<td>10 mm</td>
</tr>
<tr>
<td>Ferrule Length</td>
<td>10 – 12 mm</td>
<td>10 – 12 mm</td>
</tr>
</tbody>
</table>

**Note:** The PS4D and PS6D use the same unpluggable terminal block that accepts up to 12 AWG. The power input terminal block on the CPU20L is different and accepts up to 16 AWG. The other terminal block on the CPU20L for discrete I/O is identical to the discrete I/O terminal block on the CPU40.
Power (PS4D, PS6D, and CPU20L)

Input Voltage:
Recommended 24Vdc ±15% (20.4 – 27.6Vdc), 30V max.
Overvoltage shutdown at 36V.

Input Power:
- **PS4D**: 42W max (1.8A at 24Vdc)
- **PS6D**: 60W max (2.5A at 24Vdc)
- **CPU20L**: 28W max (2.2A at 24Vdc)

For a given power draw, the current draw will be greater at a lower input voltage.
Current draw varies based on the number and type of modules installed in the base.

Power Wiring Diagram

Ferrite for CE EMC compliance for PS4D and PS6D only. See appendix C on pg. 59.

The PS4D and PS6D Case pins are internally connected to the base chassis metal.
Discrete I/O (CPU20L, CPU40, CA4, CV8, U14)

**CPU20L**: 2 discrete inputs, 2 discrete outputs  
**CPU40**: 2 discrete inputs, 2 discrete outputs  
**CA4**: 4 discrete inputs (Fault), 4 discrete outputs (Enable)  
**CV8**: 8 discrete I/O, individually configurable as inputs or outputs  
**U14**: 4 discrete I/O, individually configurable as inputs or outputs

The CPU20L, CPU40, CA4, CV8, and U14 discrete I/O points are individually isolated.

**Discrete Inputs**

Apply 12-24V to the input. The polarity can be positive or negative. Max current draw is 3mA.

**Discrete Outputs**

The discrete outputs are solid-state relays. Outputs can be wired in either a high-side or low-side configuration.

<table>
<thead>
<tr>
<th>Output</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>On Impedance</td>
<td>15Ω max.</td>
</tr>
<tr>
<td>Max Current</td>
<td>75mA</td>
</tr>
<tr>
<td>Max Voltage</td>
<td>30V</td>
</tr>
</tbody>
</table>

**Used with a sourcing output**

**Used with a sinking output**
### Control Output (CA4, CV8, U14)

**CA4:** 4 analog outputs, individually software selectable as 0-10V, ±10V, 4-20 mA, ±20mA, or a custom range.

**CV8:** 8 analog outputs, individually software selectable as 0-10V, ±10V, or a custom range.

**U14:** 2 analog outputs, individually software selectable as 0-10V, ±10V, 4-20mA, ±20mA, or a custom range.

### Wiring to Differential Inputs

Differential inputs provide the best noise immunity. This is indicated by individual +, -, and cmn inputs on the drive or amplifier.

### Wiring to Single-ended Inputs
SSI Transducer Wiring (S8, U14)

For Synchronous Serial Interface (SSI) transducers and encoders. For linear SSI transducers, make sure to choose the synchronized type. See the SSI Fundamentals help topic in RMCTools for details.

Tip: See next page for manufacturer-specific wiring diagrams.

Notes:
- The user must supply power to the transducer.
- Connect the encoder DC ground to the Cmn pin on the S8 module or the S/Q Cmn on the U14. The Cmn must be connected to the transducer, or the signals may not be read correctly!
SSI Manufacturer-Specific Wiring

These diagrams provide transducer manufacturer labels and colors. Follow all SSI wiring instructions on page 40.

Balluff Micropulse BTL5 or BTL7 with SSI output
Styles: Z, W, K, P

MTS Temposonics with SSI output
Models: R, RP, RH
Start/Stop or PWM Transducer Wiring (S8, U14)

For magnetostrictive transducers with Start/Stop or PWM outputs.

**Tip:** See next page for manufacturer-specific wiring diagrams.

**Notes:**
- The S8 and U14 modules interface to RS-422 (3.5-5V differential) signals. Single-ended (TTL) signals are not supported.
- The user must supply power to the transducer.
- Connect the encoder DC ground to the Cmn pin on the S8 module or the S/Q Cmn on the U14. The Cmn must be connected to the transducer, or the signals may not be read correctly!
Start/Stop and PWM Manufacturer-Specific Wiring

These diagrams provide transducer manufacturer labels and colors. Follow all MDT wiring instructions on page 42.

Balluff Micropulse BTL-5, digital RS-485 output

**Styles:** Z, W, K, E, P, R, AT

<table>
<thead>
<tr>
<th>U14</th>
<th>S8</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clk/A+</td>
<td>Int/Clk+</td>
</tr>
<tr>
<td>Clk/A-</td>
<td>Int/Clk-</td>
</tr>
<tr>
<td>S/Q Cmn</td>
<td>Cmn</td>
</tr>
<tr>
<td>Dat/B+</td>
<td>Ret/Dat+</td>
</tr>
<tr>
<td>Dat/B-</td>
<td>Ret/Dat-</td>
</tr>
<tr>
<td>Case</td>
<td>Case</td>
</tr>
</tbody>
</table>

Yellow | Interrogate + Input
Pink | Interrogate - Input
White* | GND
Gray | Pulse + Output
Green | Pulse - Output
Blue | GND
Brown | Pwr+

*White wire must remain unconnected.
Do not connect Case pin to cable shield. Cable shield is internally connected to Balluff sensor housing.

MTS Temposonics with digital output (Start/Stop or PWM)

**Models:** LH, LS, LD, LF, LPS, LPR, G, EP2, ER

<table>
<thead>
<tr>
<th>U14</th>
<th>S8</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clk/A+</td>
<td>Int/Clk+</td>
</tr>
<tr>
<td>Clk/A-</td>
<td>Int/Clk-</td>
</tr>
<tr>
<td>S/Q Cmn</td>
<td>Cmn</td>
</tr>
<tr>
<td>Dat/B+</td>
<td>Ret/Dat+</td>
</tr>
<tr>
<td>Dat/B-</td>
<td>Ret/Dat-</td>
</tr>
<tr>
<td>Case</td>
<td>Case</td>
</tr>
</tbody>
</table>

Yellow | (+) Interrogation or Start
Green | (-) Interrogation or Start
Pink | (+) Gate or (+) Stop
Gray | (-) Gate or (-) Stop
White | DC Ground
Red or Brn | Cust. Supplied Pwr (+Vdc)

MTS Temposonics II with DPM or RPM personality module

<table>
<thead>
<tr>
<th>U14</th>
<th>S8</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clk/A+</td>
<td>Int/Clk+</td>
</tr>
<tr>
<td>Clk/A-</td>
<td>Int/Clk-</td>
</tr>
<tr>
<td>S/Q Cmn</td>
<td>Cmn</td>
</tr>
<tr>
<td>Dat/B+</td>
<td>Ret/Dat+</td>
</tr>
<tr>
<td>Dat/B-</td>
<td>Ret/Dat-</td>
</tr>
<tr>
<td>Case</td>
<td>Case</td>
</tr>
</tbody>
</table>

Yellow or Wh/Gy | (+) Interrogation
Green or Gyl/Wh | (+) Interrogation
White or Wh/Bu | DC Ground
Pink | Or/Wh | (+) Gate Out, (+) Start/Stop
Gray | Or/Wh | (-) Gate Out, (-) Start/Stop
Red or Wh/Gr | +VDC
Blue | Gr/Wh | - VDC
Brown or Bu/Wh | Frame

| Cmn | +Pwr | +Pwr |

*Wh/Gy | Gy/Wh | Or/Wh | Wh/Gr | Wh/Bu | Bu/Wh | Frame
Analog Input Wiring (A8, U14)

Voltage Transducer, 4- or 5-Wire

- In+ and Cmn must be connected, either internally in the transducer or externally as close as possible to the transducer.
- Use individually shielded twisted-pair wire.
- Connect cable shield to earth ground on one end only.
- If transducer has only one common, connect Pwr Supply Common and RMC Cmn to it. For best results, make this connection at the transducer.

Voltage Transducer, 3-Wire
Potentiometer with Exciter Pin (A8)

**Note:** Use the Exciter pin to increase the measurement accuracy of the potentiometer.

To reduce electrical interference:
- The connection of In- to Cmn should be made as close as possible to the potentiometer.
- Use individually shielded twisted-pair wire.
- Connect cable shield to ground on one end only.
Analog Current Wiring 4-20mA (A8, U14)

Current Transducer, 2-Wire

For three-wire transducers with a single shared common, the In-, RMC Cmn, and power supply Cmn should all be connected as close to the transducer as possible.

Input must be configured in software for current.

A8 input imped: 250Ω
U14 input imped: 165Ω
To reduce noise, use shielded twisted-pair wire.

Current Transducer, 4-Wire

Input must be configured in software for current.

A8 input imped: 250Ω
U14 input imped: 165Ω
To reduce noise, use individually shielded twisted-pair wire.
**Quadrature Encoder Wiring (Q4, U14)**

**Important:** Set the **AB Input Type** and **Z Input Type** axis parameters in RMCTools to correspond to the physical signal level and type. See the RMCTools help for details.

**Differential Signal**

![Diagram of Differential Signal Wiring](image)

**Single-Ended Signal (not recommended)**

![Diagram of Single-Ended Signal Wiring](image)
Q4 Home Inputs
Set the **H Input Type** axis parameter in RMCTools to correspond to the type of signal. See the RMCTools help for details.

![Q4 Home Inputs Diagram]

Q4 Registration Inputs
Set the **R Input Type** axis parameter in RMCTools to correspond to the type of signal. See the RMCTools help for details.

![Q4 Registration Inputs Diagram]

U14 Reg/Z Inputs
Set the **Z Input Type** axis parameter in RMCTools to correspond to the type of signal. See the RMCTools help for details.

**Differential:**

![U14 Differential Diagram]

**Single-ended:**

![U14 Single-ended Diagram]

*Reg/Z- must be connected to Cmn.*
Quadrature Wiring (S8)

The S8 supports one RS-422 quadrature encoder input, using channels 6 and 7.

Notes:
- The S8 module interfaces to RS-422 (3.5-5V differential) signals only. Single-ended (TTL) signals are not supported.
- The user must supply power to the encoder.
- Connect the encoder DC ground to the Cmn pin on the S8 module. The Cmn must be connected to the encoder, or the signals may not be read correctly!
**Load Cell Wiring (LC8)**

The LC8 supports 4- or 6-wire load cells. Inputs 0-7 are isolated as a single group. There is no isolation between inputs. Terminal block 1 contains inputs 0-3. Terminal block 2 contains inputs 4-7.

Total excitation current per terminal block must not exceed 80mA. The 6.75V excitation is intended to work with 350-ohm load cells. Load cells with lower resistance are supported, as long as the total excitation current per terminal block does not exceed 80mA.

Wire shielding is very important as the millivolt signal is very sensitive to noise. Make sure the shield is connected to the Case pin.

**4-Wire Load Cells**

![4-Wire Load Cells Diagram](image)

**6-Wire Load Cells**

![6-Wire Load Cells Diagram](image)

To use the continuous wire sense feature, the Exc+ and Exc- wires must be of the same length and gauge, since the RMC only measures the voltage drop on one and assumes the other is identical.
External Excitation

If the LC8’s 6.75V excitation causes the load cell signal to exceed the LC8 max voltage input, a lower external excitation may be used. Or, a higher excitation voltage (up to 10V) can increase load cell output as long as the Max Differential Input (±34.25mV) is not exceeded and the input voltage at In+ or In- relative to Exc- is within the Input Voltage Range (0.6V to 6.15V typical). This can improve the signal-to-noise ratio in particularly sensitive applications.

4-Wire Load Cell with External Excitation

The external Exc- pin must be connected to the LC8 Exc- pin.

6-Wire Load Cell with External Excitation

The external Exc- pin must be connected to the LC8 Exc- pin.
Strain Gauges

Strain gauges require a bridge completion circuit. The individual resistances of the Wheatstone bridge completion circuit must be matched to the strain gauge resistance. Common resistance values are 120 or 350ohms. Commercially available bridge completion modules typically offer an adjustment to zero the bridge output.

A single strain gauge requires three resistors to complete the bridge. The strain gauge may be placed in any location of the bridge. This is called a quarter bridge:

![Quarter Bridge Diagram](image1)

Two strain gauges require two resistors to complete the bridge. This is called a half bridge. The strain gauges form one side of the bridge, and the completion circuit forms the other side:

![Half Bridge Diagram](image2)

The Sense wire may be omitted if the Adaptive Exciter Mode is not used.
D24: Discrete I/O Overview

The D24 discrete I/O are organized into 4 sections:

<table>
<thead>
<tr>
<th>DI/O #</th>
<th>Features</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group A 0-7</td>
<td>Input or output – nominal 24V. Software-configurable. Each group is isolated. Within each group, all inputs share the same input common, and all outputs share the same output common.</td>
</tr>
<tr>
<td>Group B 8-15</td>
<td></td>
</tr>
<tr>
<td>Group C 16-19</td>
<td></td>
</tr>
<tr>
<td>Fast Inputs 20-23</td>
<td>Inputs only – 5V or 24V. High-speed. Each input is individually isolated. Configurable for pulse counters, quadrature inputs, and high-speed timing.</td>
</tr>
</tbody>
</table>

D24: Discrete Outputs

The D24 discrete outputs are solid-state relays. When off, they have high impedance, and when on, they have low impedance.

Outputs can be wired in either a high-side or low-side configuration. Because all the outputs in a group share a common, all outputs in the same group must be wired the same.

<table>
<thead>
<tr>
<th>D24 Outputs</th>
</tr>
</thead>
<tbody>
<tr>
<td>On Impedance</td>
</tr>
<tr>
<td>Max Current</td>
</tr>
<tr>
<td>Max Voltage</td>
</tr>
</tbody>
</table>
## D24: Discrete Inputs

To turn on a discrete input, apply a voltage of the correct level. The polarity is unimportant for inputs 0-19 and is important for 20-23.

<table>
<thead>
<tr>
<th></th>
<th>Inputs 0-19</th>
<th>Inputs 20-23</th>
</tr>
</thead>
<tbody>
<tr>
<td>Signal Levels</td>
<td>12-24Vdc</td>
<td>5-24Vdc</td>
</tr>
<tr>
<td>Max Current Draw</td>
<td>3mA</td>
<td>7mA</td>
</tr>
</tbody>
</table>

Inputs 0-19 are polarity-independent and can be sinking or sourcing. Inputs 0-19 are divided in three groups: 0-7, 8-15, 16-19. Each group shares a common, so all inputs in a group must be wired the same.

**Used with a sourcing output**

**Used with a sinking output**

### Inputs 20-23

Each input is individually isolated and has Din+, Din +5V, and Din– connections. Use only Din+ or Din+5V, not both.

**Example:**

---

---
D24: Quadrature Encoder

The D24 high-speed inputs 20-23 support the following quadrature encoder feedback and pulse train signal types:

- 5V Differential
- Differential HTL (High Threshold Logic) for 12V to 24V
- RS-422
  RS-422 will only work in this configuration if the differential output is greater than 3.5V. Some RS-422 drivers may not provide sufficient voltage.
- TTL
- Push-pull 5V-24V without complements
- Open collector from 5V to 24V
- RS-422 (3V)
  Use RS-422 in this configuration only if the differential output is less than 3.5V.

For detailed wiring diagrams, see the D24 wiring topic in the RMCTools help.
Appendix B: Mounting Dimensions

Clearance

The required clearance above and below for airflow depends on the maximum ambient temperature:

<table>
<thead>
<tr>
<th>Ambient Temperature</th>
<th>Clearance</th>
</tr>
</thead>
<tbody>
<tr>
<td>122 - 140°F (50 - 60°C)</td>
<td>3 in. (7.6 cm)</td>
</tr>
<tr>
<td>Less than 122°F (50°C)</td>
<td>2 in. (5.1 cm)</td>
</tr>
</tbody>
</table>

Bases

B5L:  
Side View, All Bases:

Units are in inches [mm]. See www.deltamotion.com/dloads/ for CAD files.
Appendix B: Mounting Dimensions

B5:

B7:

B11:

Units are in inches [mm]. See deltamotion.com/dloads/ for CAD files.
B15:

Units are in inches [mm]. See deltamotion.com/dloads/ for CAD files.
Appendix C: Agency Compliance

CE

All RMC200 modules are CE compliant.

For CE compliance and to minimize electrical interference:
- Install a ferrite ring on the power wires to the PS4D or PS6D power supply module. Recommended ferrite is Fair-Rite 0431167281.
- Use twisted pairs for all wiring where possible.
- Use shielded cables for all wiring.
- Keep RMC wiring separate from AC mains or conductors carrying high currents, especially high frequency switching power such as conductors between servo drives and motors or amplifiers and proportional valves.
- Keep doors on modules closed during operation.

UL and CUL

File Number: E141684

RMC200

All modules are UL and CUL compliant.
Connect. Control. Optimize.